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Introduction

The Archive Manager Outlook Add-in offers end users the capability to archive, retrieve, restore
and search for archived email items directly from the Outlook client installed on their computers.

This guide describes the all these features and other capabilities of the Outlook Add-in.

1 | NOTE: Native rehydration or exports are intended for small data sets. For operations on

large data sets, use a specialized utility such as Quadrotech Archive Shuttle (QAS).

When the Outlook Add-in is installed, the Archive Manager tab appears in the Outlook toolbar.
The various functions available in the toolbar ribbon are shown in the illustration below. For
more information about the installation and permission settings that control the functions in the
ribbon, see the Archive Manager for Exchange 8.9 Outlook Add-in Installation Guide.

Inbox - timashford@democorp.com - Qutlook
Home Send / Receive Folder View ARCHIVE MANAGER Q Tell me what you want to do
. falal = Py
Ba Bk @ | 4b G
Default K X X
Restore Delete Versions Search Offline folder Options Infa
synchronization
Archive Restare Keywaord search | Offline folder synchronization! Options Info o~
- <
4 Favorites Search Current Mailbox & | Current Mailbox  ~ &Raply @(lREpIyAII Eﬁ,FUrward
Inbox Fri 9/11/2020 2:34 &AM
All  Unread By Date = Newest 4 . p
Sl -+ otser nikipartman@democorp.com
Diatts . a Housekeeping
Deleted ltems nikiportman@demac... 5 o Tim Ashiord
Housekeeping 9/11/2020 o Tim Ashtor A
Accounts-News 5 Fingerbone is a fictional
c N 7 Metalogix Archive Manager + Get more add-ins
aompany-MNews -
=y davidwebb@democ...
Products-Mews The Catcher in the Rye 9/11/2020 =
— n No matter how many high Fingerbone is a fictional town in the Atlantic Northwest. It rests along
ales-News
a lake that has the distinction of once having claimed an entire train
pabloneruda@demo... that slid from a bridge into its dark waters one night, taking almost all
- Three Women 9/11/2020 . . . .
4 timashford@democorp.c... This singular work of on board to their deaths. Time swallows people in the same way in
b Inbox this sly book. The narrator is Ruth, a teenaged girl. She and her sister
B ninatanaka@democo.. are raised, affectionately but haphazardly, by various generations of
A The Other Americans 8/11/2020 the women in her all-too-eccentric family. This is a book about
Sent Items When a Maraccan immigrant women, making homes and leaving them. Even when the girls stay
Deleted Items nikiportman@democ home, the days and nights pass and the plot goes nowhere in
Junk Email survival Math 9,11/2020 particular, Robinson arrives again and again in resounding places.
Jackson grew up in one of
. ) Regards
= om s e karljordan@democor... Niki =
On Earth We're Briefly Gor... 9/11/2020 hd
Items: 22 All folders are up to date.  Connected to: Microsoft Exchange 1 B - ' ] +  100%

When email items are archived, special icons are used to indicate the nature of the archived
email item as described in the table below:

Icon Description

&

e
=

Archived email that has been replied.

Archived e-mail. A bold font indicates that the email is archived and unread.
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Description

Archived email that has been forwarded

NOTE: When you open Outlook for the first time after installing the Archive Manager
Outlook Add-in, it will take longer than usual because the Add-in is loaded and configured
automatically. When you open Outlook the next time, the interval will be shorter. The
Archive Manager toolbar is also listed in the File > Options > Customize Ribbon window. All
Outlook Add-in actions are logged to a log file located in the $AppData%\Quest
Software\Archive Manager\Log\Archive Manager folder.

Outlook® is a registered trademark of Microsoft Corporation. All features of the Archive
Manager Outlook Add-in are valid for Outlook 2016 and later.
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Archiving emails

You may choose to archive several e-mails or documents at once. When archived, emails will be
residing in the archive until its retention time elapses. The archived email can be even deleted
from Outlook, however, it will be still accessible e.g. via keyword search.

Steps to archive emails
1. Click the Archive Manager addin.

2. Select one or more emails and click Archive from the ribbon. You can also archive emails and
documents from the Public Folders folder if you have the appropriate permissions which can
be assigned in Archive Manager for Exchange Administration Center (AMAC).

Inbaox - timashford@democorp.com - Outlook

File Home Send / Receive Folder View Help ARCHIVE MANAGER Q Tell me what you want to do

Archive Restore Keyword search | Offline folder synchronization! Options Info o~

Archive Restore Delete Versions Search Offline folder Options Info

synchronization

3. Choose aretention category from the adjoining drop-down box, which will be used when
archiving the selected emails. The retention category defines the period to retain archived
emails, whether the shortcut should be created and more. For more information on retention
categories see the Archive Manager for Exchange Administration Guide.

4. During the archiving process the Progress box opens.

Archivingmessages El
\.'.

Message 0/ 1

Cancel

5. After an email is archived it can be retrieved and opened by double-clicking the archived
email. It can take some time while Outlook retrieves the emails from the archive and you
might see the following popup window.

0 Downloading archived message

Please wait!

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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Restoring archived emails

Archived emails can be restored from the Archive Manager Outlook addin.

Steps to restore archived emails
1. Click the Archive Manager addin.
2. Select one or more archived emails and click Restore from the ribbon.

Inbox - timashford@democorp.com - Outlook

File Home Send [ Receive Folder View Help ARCHIVE MAMAGER Q Tell me what you want to do

1 2 A = - =
L\ Bk g 4 & @ | O
au
Restore Delete Versions Search Offline folder Options Infa
synchronization
Archive Restore Keyword search  Offline folder synchronization' Options Info ~
i <
4 Favorites Search Current Mailbox | Current Mailbox = £ Reply @-REPWA” 3 Forward
Inbox Fri 9/11/2020 2:34 AM
All Unread By Date ™ Mewest ¢ _
Sentiens o nikiportman@democorp.com
ler
EED o B Housekeeping
nikiportman@democ... &
Deleted ltems To Tim Ashford|
Housekeeping 9/11/2020 o Tim Ashror ~
Accounts-News 5 Fingerbone is a fictional
c N 7 Metalogix Archive Manager + Get more add-ins
ompany-News -
[ davidwebb@democ...
Products-News The Catcher inthe Rye 9/11/2020 =
Tl a Mo matter how many high Fingerbone is a fictional town in the Atlantic Northwest. It rests along
alesiews a lake that has the distinction of once having claimed an entire train
pabloneruda@demo.. o that slid from a bridge into its dark waters one night, taking almost all
4 timashford @democorp.c... mirseii:\;lr\n:r'lvork of 31172020 on board to their deaths. Time swallows people in the same way in
b Inbox this sly book. The narrater is Ruth, a teenaged girl. She and her sister
Bt ninatanaka@democo... are raised, affectionately but haphazardly, by various generations of
& The Other Americans 9/11/2020 the women in her all-too-eccentric family. This is a book about
Wi ;
Sent Items When a Moroccan immigrant women, making homes and leaving them. Even when the girls stay
Deleted [tems nikiportman@democ home, the days and nights pass and the plot goes nowhere in
Junk Email Survival Math 9/11/2020 particular, Rebinson arrives again and again in resounding places.
Jackson grew up in one of
) Regards
F=oas g e karljordan@demacor... ik -
On Earth We're Briefly Gor... 9/11/2020 -
Items: 22 Allfolders are up to date.  Connected to: Microsoft Exchange o e - 1 + 00

3. Click Restore in the Restore messages window that opens.

Restore messages

B Restoring messages

[] Delete from archive | Restore | | Cancel |

4. Delete from archive - select this check box to mark the selected emails in the archive for
deletion. They will be deleted from the archive when their retention period expires.
However, it is still possible to find these archived emails with the Search feature until they
are physically deleted from the archive when their retention period expires. If the check box
is not checked, the emails will be restored but will not be marked for deletion from the
archive. The shortcuts of the email will be replaced on the MS Exchange Server with the
original email.

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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5. When the restoration starts the Progress window opens.

Progress

Restoring messages

Message 0/ 1

Cancel

1 | NOTE: If you delete archived emails from your mailbox using the Outlook's Delete action, it
is still possible to find them with the Archive Manager addin Search feature. However, only
the Archive Manager administrator can restore them back into the mailbox.

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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Deleting archived emails

With this menu option the archived e-mails are deleted from the Exchange Server. They can also
be marked for deletion from the archive and consequently, they will be deleted when the
retention period expires.

Steps to delete archived emails

1 | NOTE: To ensure the delete process is successful, you must deactivate the Cached
Exchange Mode in Outlook.

To deactivate Cached Exchange Mode in Outlook:
1. Click File > Account Settings > Account Settings.
2. Click the Exchange or Microsoft 365 account from the Email tab, and then click Change.

3. Under Offline Settings, uncheck Use Cached Exchange Mode. If you're a Microsoft 365
subscriber, uncheck Use Cached Exchange Mode to download email to an Outlook data
file.

4. Exit, and then restart Outlook.

Alternatively, you can keep Cached Exchange Mode activated and set Mail to keep offline
(or Download email for the past for Microsoft 365 subscribers) to a date range greater than
the received emails being deleted.

1. Click the Archive Manager addin.
2. Select one or more archived emails and click Delete from the ribbon.

3 - = Inbox - timashford@democorp.com - Outlook

Home Send / Receive Folder View ARCHIVE MAMAGER Q Tell me what you want to do

Gl s e bl B . o
Default
Restore| Delete | Versions Search Offline folder Options Info

synchronization

Archive Restare Keyword search | Offline folder synchronization | Options Info .

3. Inthe Delete from archive window, click Delete.

Delete from archive

*i You have selected 1 messages.

Do you really want to delete?

[ ] Delete from archive Delete | | Cancel

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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4. By not selecting the Delete from archive check box only the email shortcut will be deleted
from the Exchange Server. However, the email will not be marked for deletion in the archive
and the email is displayed as lost in the Archive Manager Administration Center (AMAC). It can
be restored by the administrator during its retention period or until the Shortcut
synchronization job runs. For more information see the Archive Manager for Exchange

Administration Guide.

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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In this chapter:

e Keyword Search

e Advanced Search

e How to build search queries

Keyword Search

Search

Keyword search is used for searching through archived emails and attachments. It is possible to
search for text in pictures (OCR search) although this technology has some limitations. For
example, tiny text may not be correctly recognized. Keyword search can be used for searching

through archived and subsequently restored mails.

Steps to run a keyword search
1. Click the Archive Manager addin.
2. Click Search from the ribbon.

Inbox - timashford@democorp.com - Cutlook

File Home Send / Receive Falder View Help ARCHIVE MANAGER Q Tell me what you want to do

1 == = o, —

=) T Bk e | 4b - & | O
aul

Restore Delete Versions Search Offline folder Options Info

synchronization

Archive Restare Keyword search | Offline folder synchronization | Options Infao

3. The Search window opens.

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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Keyword search ER

Keyv.'nrd:| | | Search | ‘ Clear |
Advanced search
=]
Advanced "Mailboxa " Settings
AndfOr  Field Operator Value

=+ Add new clause
Search results:

From Subject Attachment Size Version Received Archived date  Folder

€ >
‘ Load || Save | —a | Display | Clase

4. Enterthe keywords in the Search for the word(s) field. The keyword is searched in the subject,

email body and attachments.

5. The result of the search is then displayed in the Search results window.

Keyword search mERR

Keyward: |bnnk | | Search | ‘ Clear |

Advanced search
=]
Advanced " Mailboxes " Settings
AndfOr  Field Operator Value

=+ Add new clause
Search results: 2 messages found

From Subject Attachment Size Wersion Received Archived date  Folder

(=i nikiportma... Housekesping 742KB 1 9/11/2020 2:34:0... 3/30/2021 1:02:3... Inbox/Conferenc..,
(= davidwebb... The Catcher... 5.95 KB 1 9/11/2020 2:33:5... 3/30/2021 12:56:... Inbox/Conferenc..,
£ >
‘ Load || Save | - | Display | Clase

6. From the the Search results window, you can retrieve an archived email by either selecting the

email and clicking Display or by double-clicking the email.

Search Expressions

Search expressions are a combination of keywords and logical operators that enhance the search

capability. Keywords can be used in combination with the logical operators AND, OR. The
operator AND is not mandatory. If no logical operator is included, the keyword search query
engine searches for documents containing all the given words.

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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Full text search

Keyword: |hel|n OR welcome | | Search | | Clear
Advanced search
Search results: 5 messages found

From Subject Attachment Size Version Received Archived date  Folder

(=4 Domain ... CEQ nomi... 5.25KB 1 10/4/2019 6:22:1...  11/25/20196:09:... SentItems

(=1 Domain ... Hello 3.25KB 1 5 11/25/2019 6:09:... SentItems

(=i Domain ... Hello 7.39KB 1 11/25/2019 6:09 Inbox

(=i Domain ... Welcome 7.43KB 1 11/25/2019 6:09:... Deleted Items

(=i Domain ... Welcome 3.27KB 1 1012019 12:51:... 11f25/2019 6:09:... SentItems

<

Load | | Save ‘ a1 Display ‘ | Close

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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Example 1:

Search results forhello AND welcome are the same as search results for the stringhello
welcome Oof welcome hello. When youintend to look for an exact phrase (a group of words that

functions as a single unitin the syntax of a sentence) you should use quotation marks " ".

Example 2:

Archive Manager Search supports other operators: NOT, + and -. Single and multiple character
wildcard searches are supported as well:

Character

NOT

Description

single character wildcard; replaces any
single character

multiple character wildcard; replaces
0 or more characters

requires that the term after the "+"
symbol exist somewhere in a the field
of a single document

excludes documents that contain the
term after NOT. This is equivalent to a
difference using sets. The symbol !
can be used in place of the word NOT

Note: The NOT operator cannot be
used with just one term. For example,
the following search will return no
results: NOT "test server".

excludes documents that contain the
term after the "-" symbol

Example

te?t matches text, test etc.

test* matches test, tests, tester etc.

+test data

searches for documents that must
contain "test" and may contain "data"
"test data" NOT "test server"

searches for documents that contain
"test data" but not "test server"

"test data" -"test server"

searches for documents that contain
"test data" but not "test server"

1 | NOTE: The above mentioned wildcard specification characters, i.e. ? or * etc., cannot occur

as first 2 characters of the search phrase. The search query as such cannot other contain
special characters as ":", "\", "I", "A", et

You can use the Save / Load buttons to save / load search criteria you have specified. Itis
especially useful e.g. when you have set special settings for Advanced search (see further).



Advanced Search

Advance search lets you specify your search criteria in more detail.

Steps to use advanced search

1. Click the plus (+) sign to expand the advanced search section.

Full text search ER

Search

Keyword: ‘

Clear |

Advanced search

Search results: 0 messages found

From Subject Attachment Size Version Received

€

Archived date  Folder

>

| Load | | Save | —a Display

Close

2. Click the Advanced tab.

3. Click Add new clause and enter the search criteria using the fields as described below:

a. Field - click the drop down to select the property of the email to be searched. For example,

select Subject as the field to search.

b. Operator - click the drop down and select a search operator.

c. Value - Specify the search text. If the selected Field requires a date value, a date picker
icon appears to help you choose a date. This field supports wildcard characters.

4. To add more criteria clauses, click Add new clause or +. To remove a clause click . You can
additionally select the logical operator. The default operator is And.

i | NOTE: You can group clauses to create nested search criteria by selecting consecutive

check boxes and clicking the [=icon.

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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Full text search ER

Keyword: ‘ | | Search ‘ | Clear |
Advanced search
=
Advanced | Mailboxes | Settings
AndfOr  Field Operator Value

+ X0 |Subject v||= VHHello |

+ x 0 |o|— V||S|_|hject v||= vHWeIcome |

=+ Add new clause
Search results: 0 messages found

From Subject Attachment Size Version Received Archived date  Folder

< >
| Load || Save | =& Display Clase

5. Toview the scope of the search on mailboxes, click the Mailboxes tab. By default only the
current mailbox is added. You must select more mailboxes manually if you want to search
additional mailboxes.

NOTE: If you do not see additional mailboxes, the Administrator must follow the steps
below to expand the search scope to more mailboxes:

a. Openthe Address Book Manager in the Archive Manager for Exchange
Administration Center (AMAC).

b. Click Mailboxes to open the list of mailboxes.

c. Right-click the mailbox you want to add and select Permissions from the context
menu. The Mailbox rights window opens.

d. Click Add and select the Outlook user who will run the search. Then click OK to close
the windows.

e. Open the Advanced search window again and click the Mailboxes tab to view the
additional mailboxes

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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Keyword: ‘ | |

Search ‘ | Clear |

Advanced search

Advanced || Mailboxes "Settmgs ]

Mailbox
Niki Portman
Ishna Mohan
Devika Sharma

=

Search results:

From Subject Attachment Size Version Received Archived date  Folder

>

| Load | | Save | =& | Display | Clase

6. To setthe search scope on email item types, click the Settings tab.

Keyword: ‘ | | Search ‘ | Clear |

Advanced search

=

Advanced "Mailboxa "Settmgs ]

Limit search results to: 10000 =

[] search in archived and deleted documents
[ searchin deleted documents

[] search in versions. The match will be shown for each version separately.

Search results:

From Subject Attachment Size Version Received Archived date  Folder

>

| Display | Clase

| Load | | Save | =&

Configure the settings as described below:
a. Limit search results to - the number of emails that are returned in the search result list.
b. Search options allow you to specify the category of documents to search.

e No selection - only archived documents are searched. Previous versions of these
documents are notincluded.

Select one of the following options:

e Search in archived and deleted documents - all documents will be searched. Previous
versions of these documents are not included.

e Search in deleted documents - deleted documents and documents that are marked for
deletion will be searched. All other archived documents will be ignored. Previous
versions of these documents are not included.

Add an additional criteria:

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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e Search in versions - Previous versions will be included for the document category

specified. The match will be shown for each version separately..

7. Click Search to search for archived emails based on the selection criteria, the mailboxes
specified and the settings that are applied.

Keyword: ‘ | | Search ‘ | Clear |

Advanced search

=
Advanced | Mailboxes | Settings
AndfOr  Field Operator Value
+ x 0 |SubJect ~ ‘ |He||o |
+ X [ |Or ~ | |SubJEct ~ ‘ |We\cume |
=+ Add new clause
Search results: 4 messages found
From Subject Attachment Size Version Received Archived date  Folder
i Domain ... Hello 7.39KB 1 1012019 7:00:3... 11/25/2019 £:09:... Inbox
—i Domain ... Hello 3.25KB 1 10/12019 7:00:3... 11/25/2019 6:09:... Sent Items
i Domain ... Welcome 7.43KB 1 10/1/2019 12:51:...  11/25/20196:09:... Deleted Items
—i Domain ... Welcome 3.27KB 1 10/1/2019 12:51:...  11/25/2019 6:0%:... SentItems
< >
| Load | | Save | = Display Close

8. Click Save to save the search criteria as an XML file. The saved search criteria does not include

the list of mailboxes used in the search scope. Click Load to load a previously save search
criteria.

How to build search queries

This topic describes how to build search conditions using the advanced search capabilities of
Archive Manager for Exchange. A search condition (or query) can contain zero or more search
clauses that are combined using operators and grouping of search clauses.

In this topic:

e Simple Conditions

e AND/OR operators

e Grouping

e Keyword Search

Simple Conditions

A simple search conditions needs no search clause or can contain just one search clause.

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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Example 1

Click Search without adding a search clause. In this case, you will get back all the archived items.

Keyword search rPER

Keywaord: | | | Search | | Clear |
Advanced search
=]
Advanced " Mailboxes " Settings ]
And/Or Field Operakar Yalue
=+ Add new cdause
Search results: 91 messages Found
From Subject Attachment Size Wersion Received Archived date  Folder 2
LE 1.45 KB 1 7Fl21{2021 11:200,,,  §f19/2021 4:10:0... Contacts/Recipien
(=i amadmin & seventy... 9.65 KB 1 2/9f2021 3:02:57...  6/19/2021 4:10:0... Inbox
(=i amadmin  voice addr... 5,08 KB 1 2192021 3:02:57... &/19/2021 4:10:1... Inbox
(= amadmin "who gav... rm 142,38 KB 1 Zl912021 3:02:57... /192021 4:10:1...  Inbox
(= amadmin & sevenky... 5.2KB 1 2/912021 3:02:57... 8/19/2021 4:11:0... Sent Items
(=3 amadmin  woice addr... 378 KB 1 /92021 3:02:57... §/19/2021 4:11:0... Sent Items hd
£ >
| Laad | | Save ‘ == | Display | Close

Example 2

Add a single search clause with a condition where the field Subject contains the word "them”.

When you click Search, you will get back all the archived items where the Subject contains the
word "them".

Keyword search rPER

Keyward: | | | Search | | Clear |
Advanced search
=]
Advanced " Mailboxes " Settings ]
And/Or  Field Operakaor Yalue
+ X O ‘Subject v||Contains V||them
+ Add new clause
Search results: 4 messages found
From Subject Attachment Size Versian Received Archived date  Folder
mamadmin French sin. .. 4.41 KB 1 2092021 2:46:44...  5/19/2021 4:09:4... Calendar
= sajadedt,., 1) B9.26 KB 1 209{2021 2:46:35..,  §/19/2021 4:10:3... Inbox
= splashing ... .42 KB 1 2092021 2:46:30.,.  6/19/2021 4:10:5...  Inbox
= of them h... rm 91,862 KB 1 21902021 2:46:29.,,  8/19/2021 4:10:5...  Inbox
< >
Laad | | Save ‘ - | Display | Close

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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AND/OR operators

The AND/OR operator is used between two search clauses. With these operators, you can
combine two or more search clauses. The AND operator will return a search result if both the
search clauses separated by the AND operator are fulfilled. The OR operator will return a search
result if any one of the search clauses separated by the OR operator are fulfilled. The AND
operator has a higher priority over the OR operator. When a search condition contains both the
AND and OR operators, the search clauses that are combined with the AND operator must be
fulfilled first.

Example 1

To find all items where the Subject contains word "them" AND the Sender is "amadmin", you
must combine two search clauses as shown:

Keyword search rER

Keyword: | | | Search || Clear |

Advanced search

Advanced | Maiboxes || Settings

And/Or Field Operakar Value
+ x[O ‘Subject V||Contains V||them |

=]

+x[O |And VHme V||= v||amat:|min |

+ Add new cause

Search results: 1 messages found

From Subject Attachment Size Versian Received Archived date  Folder

%amadmln French sin... 4.41 KB 1 2[912021 Z2:46:44... 19/2021 :09:4... Calendar

< >

Load | | Save ‘ =3 Display Close

Example 2

To find all items where the Subject contains word "them" OR the Sender is "amadmin", you must
combine two search clauses as shown:

Quest® Archive Manager for Exchange Outlook Add-in User Guide
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Keyword search rPER

Keyward: | | | Search | | Clear |
Advanced search
B
Advanced | Mailboxes || Settings
And/Or  Field Operakaor Yalue
+ X O ‘Subject ~ | |Contains ~ | |them |
+ X O |Or VHFrom V||= V||amadmin |
+ add new dause
Search resulks: 63 messages Found
From Subject Attachment Size Versian Received Archived date  Folder e
(=) amadmin & sevenky... 9.65 KB 1 2/9f2021 3:02:57... 8/19/2021 4:10:0... Inbox
(=i amadmin  voice addr... 8.08 KB 1 2/9f2021 3:02:57...  8/19/2021 4:10:1... Inbox
(= amadmin  "who gav... rm 142,38 KB 1 2/9f2021 3:02:57...  6/19/2021 4:10:1... Inbox
(=i amadmin & seventy... 5.2 KB i /912021 3:02:57... &/19/2021 +:11:0... Sent Items
(= amadmin voice addr,., 3.78 KB 1 Z2/912021 3:02:57... &/19/2021 +:11:0... Sent Items
(= amadmin “Who gav... rm 138.36 KB 1 2/972021 3:02:57... &/19/2021 4:11:0... Sent Items hd
< >
| Laad | | Save ‘ - | Display | Close

Grouping

Sometimes simple combinations of search clauses with the AND and OR operators are not
enough. Grouping is a good solution to change the priority between the operators. The grouped
search clauses have a higher priority than the operator before or after the group. The examples in
this section describe how the grouping works.

Example 1

To find all items where the Subject contains the word "them" AND the Sender is "amadmin", and
all these items must also have an attachment then the search condition is as shown:

Keyword search A=

Keyword: | | | Search | | Clear |
Advanced search
=]
Advanced | Mailboxes || Settings
Andior  Field Operabar Value
+ x O |Sub]‘ect ~ | |C0nta\ns ~ | ‘them |
+ x[O ‘Or V||From V||= VHamadmin |
+ x O ‘And ~ | |Has Attachment | |= ~ | ‘Yes ~ |
+ Add new cause
Search results: 14 messages found
From Subject Attachment Size Wersion Received Archived date  Folder 2
(= amadmin  "who gav... rm 142,38 KB 1 2/9f2021 3:02:57...  6/19/2021 4:10:1... Inbox
(= amadmin "who gav... rm 138,36 KB 1 Z/912021 3:02:57... &/19/2021 +:11:0... Sent Items
(=3 amadmin  blood und... rm 93.07 KB 1 Z2/912021 3:02:54... &/19/2021 ¢:10:1... Inbox
(=i amadmin  blood und... rm 858.84 KB 1 2/912021 3:02:54... 8/19/2021 4:11:0... Sent Items
(= amadmin  notwishit,.. T 314.56 KB 1 2092021 2:56:25.., §/19/2021 4:10:1... Inbox
(=l amadmin  notwishit,.. T 310,49 KB 1 2092021 2:568:25..,  §/19/2021 4:11:1... Sent Items b
< >
| Load | | Save ‘ a1 | Display | Close

Query: (Subject contains "them” OR Sender is "amadmin") AND has attachment
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We can split this search condition into two parts
1. (Subject contains "them” OR Sender is "amadmin”) which is a group
2. AND has attachment

Since a grouping has a higher priority, the search condition in the group must be fulfilled first. In
this case each item in the search result will have a Subject that contains the word "them” AND the
Senderis "amadmin”, and the item will also have an attachment

Example 2

To find all items where the Subject contains word "them” or, the Sender is "amadmin” and at the
item must have an attachment, then the query is as shown:

Keyword search PR

Keyword: | | | Search || Clear |
Advanced search

=]
Advanced | Maiboxes | Settings

And/Or Field Operator WValue

+ x O ‘Subject V||C0ntains V||them |
+ X O |Or VHFrom V||= V||amadmin |
+ X O |And VHHas Attachment V||= V||Yes V|

+ add new cause

Search results: 16 messages found

From Subject Attachment Size Wersion Received Archived date  Folder e
~jamadmin  "who gav... rm 142,38 KB i /912021 3:02:57... &/19/2021 +:110:1...  Inbox
~lamadmin  "who gav... rm 138,36 KB 1 Z2/912021 3:02:57... &/19/2021 +:11:0... Sent Items
~iamadmin  blood und... rm 93.07 KB 1 2/912021 3:02:54... &/19j2021 ¢:10:1...  Inbox
i amadmin bload und... 1) 85.84 KB 1 2092021 3:02:54... §f19/2021 4:11:0... Sent Items
Zamadmin notwishit,.. 1) 314.56 KB 1 2/9f2021 2:56:25.,,  §/19/2021 4:110:1... Inbox
i amadmin ot wishit... rm 310,49 KB 1 2092021 2:568:25.., 6/19/2021 4:11:1... Sent Items he

< >

| Load | | Save ‘ == Cisplay Close

Query: Subject contains "them” OR Sender "admin” AND has attachment
This query can be split into two parts

1. Subject contains "them” OR

2. Senderis "amadmin” AND the item has an attachment

The AND operator has a higher priority so the search clauses combined with the AND operator
must be fulfilled first. In this case the search result will contain items where the item must have
an attachment and the Sender must be "amadmin”, or Subject should contain the word "them”.

Example 3

To find all items where the Subject contains the word "them" and the Sender is "amadmin”, or the
item has attachment, and the item must be in the "Inbox" folder then the search condition is as
shown:
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Keyword search rPER

Keyward: | | | Search | | Clear |
Advanced search
B
W Mailboxes || Settings
Andfor  Field Operabor Value
+ X O |Subject “ | |Conta\ns ~ | ‘them |
+ x OIE ‘And v||Fr0m V||= VHamadmin |
+ x O ‘Or e | |Has Attachment - | |= ~ | ‘\"es ~ |
+ x O ‘And ~ | |Fu\dar Path w | |= ~ | ‘Inbux |
+ add new cause

Search results: 2 messages found

From Subject Attachment Size Versian Received Archived date  Folder

= =0 jaded k... rm 89.26 KB 1 2/9/2021 2:46:35...  8/19/2021 #110:3...  Inbox

3 of them h... Im 91.82 KB 1 20902021 2:46:29...  8/19/2021 4110:5...  Inbox

< >
| Laad | | Save ‘ - | Display | Close

Query: subject contains "them” AND (Sender is "amadmin" OR has attachment)
AND Folder path is "Inbox"

This query can be splitinto three parts

1. Subject contains "them” AND

2. (Senderis "amadmin” OR the item has an attachment)
3. AND Folder path is "Inbox”

The grouped search clauses have the higher priority in this query so the search condition in the
group must be fulfilled first. In this case the search result will contain items where the Subject
must contain the word "them” + Sender should be "amadmin” or the item has an attachment + the
folder path must be "Inbox”.

Example 4

To find all items where the Subject contains the word "them” and Sender is "amadmin”, or the
item has an attachment and these items should be in the "Inbox” folder then the search query is
as shown:
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Keyword search rPER

Keyward: | | | Search | | Clear |
Advanced search
=]
Advanced | Mailboxes || Settings
And/Or  Field Operakaor Yalue
+ X O ‘Subject v||Contains V||them |
+ X O |And w | ‘From v | |= w | |amadmin |
+ x O |Or ~ | ‘Has Attachment ~ | |= ~ | |\"es ~ |
+ x O |Ar|d ~ | ‘Fulder Fath ~ | |= ~ | |Ir|bc|x |
+ add new cause
Search resulks: 17 messages Found
From Subject Attachment Size Versian Received Archived date  Folder e
i amadmin "who gav... T 142.38 KB 1 2/9f2021 3:02:57... 8/19/2021 4:10:1... Inbox
Zamadmin  bload und... 1) 23.07 KB 1 2/9f2021 3:02:54...  §/19/2021 4:10:1... Inbox
i amadmin ot wishit... rm 314.56 KB 1 2092021 2:568:25..,  6/19/2021 4:10:1... Inbox
~jamadmin  back seize... rm 71.32 KB i Zlofz0zl :56:22,,. &/19/2021 +:110:2...  Inbox
%amadmln French sin... 4,41 KB 1 Z2[912021 Z2:46:44,,, /192021 4:0%:4... Calendar
= querulous... rm 77.48 KB 1 2/912021 2:46:38...  §/19/2021 ¢:110:2...  Inbox hd
< >
| Laad | | Save ‘ - | Display | Close

Query: Ssubject contains "them" AND Sender is "amadmin" OR has attachment AND
Folder path is "Inbox"

This query can be splitinto two parts
1. Subject contains "them” AND Senderis "amadmin” OR
2. Item has attachment AND Folder path is "Inbox”

The AND operator has a higher priority in this query so the conditions with the AND operators
must be fulfilled first. In this case the search result will contain all items where Subject contains
the word "them" and Sender is "amadmin" or the item must have an attachment and the folder
path must be "Inbox".

Example 5

To find all items where the Subject contains word "them” or these items are in the "Inbox”
folder, and the Sender is "amadmin” or the item has an attachment, then the query is as shown:

Quest® Archive Manager for Exchange Outlook Add-in User Guide

25
Search



Keyword search rPER

Keyward: | | | Search | | Clear |
Advanced search
=]
Advanced | Mailboxes || Settings
Andfor  Field Operabor Value
+ x OE |Subject “ | |Conta\ns ~ | ‘them |
+ X O ‘Or V||F0\der Path V||= VHInbox |
+ x OE ‘.ﬂnd V||From V||= VHamadmin |
+ x O ‘Or V||HasAttachment V||= VHYES V|
+ add new cause
Search resulks: 33 messages Found
From Subject Attachment Size Versian Received Archived date  Folder e
—iamadmin & seventy... 9.65 KB 1 2/9f2021 3:02:57... 8/19/2021 4:10:0... Inbox
—j amadmin  voice addr... 8.08 KB 1 2/9f2021 3:02:57...  8/19/2021 4:10:1... Inbox
i amadmin "Who gav... rm 142,38 KB 1 2/9f2021 3:02:57...  6/19/2021 4:10:1... Inbox
~jamadmin  up and do... 13.66 KB i Z/9/2021 3:02:56.,. &/19/2021 +:10:1...  Inbox
~iamadmin  drooping ... 8.28 KB 1 2/9/2021 3:02:55... &/19/2021 ¢:10:1... Inbox
~lamadmin  Mademois... 12.29KB 1 2/972021 3:02:55... &/19j2021 ¢:10:1... Inbox hd
< >
| Laad | | Save ‘ - | Display | Close

Query: (Subject contains "them” OR Folder path is "Inbox") AND (Sender is
"amadmin" OR has attachment)

This query can be splitinto two parts
1. (Subject contains "them" OR Folder path is "Inbox") AND
2. (Senderis "amadmin" OR item has attachment)

The grouped condition has the higher priority in this query so the conditions in the group must be
fulfilled first. In this case the search result will contain items where Subject should contain
"them” word or folder path should be "Inbox” + Sender should be "amadmin” or the item should
have an attachment.

Example 6

To find all items where the Subject contains the word "them" or, these items are in the "Inbox”
folder and the Senderis "amadmin”, or the item has an attachment, then query is as shown:
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Keyword search rPER

Keyward: | | | Search | | Clear |
Advanced search
=]
Advanced | Mailboxes || Settings
And/Or  Field Operakaor Yalue
+ X O ‘Subject ~ | |Contains ~ | |them |
+ X O |Or w | ‘Folder Path v | |= w | |Inb0x |
+ x O |And ~ | ‘From ~ | |= ~ | |amadmin |
+ x O |Or ~ | ‘Has Attachment | |= ~ | |Yes ~ |
+ add new cause
Search results: 44 messages Found
From Subject Attachment Size Versian Received Archived date  Folder e
—iamadmin & seventy... 9.65 KB 1 2/9f2021 3:02:57... 8/19/2021 4:10:0... Inbox
—j amadmin  voice addr... 8.08 KB 1 2/9f2021 3:02:57...  8/19/2021 4:10:1... Inbox
i amadmin "Who gav... rm 142,38 KB 1 2/9f2021 3:02:57...  6/19/2021 4:10:1... Inbox
~jamadmin  "who gav... rm 158,36 KB i /912021 3:02:57... &/19/2021 +:11:0... Sent Items
~lamadmin  up and do... 13.66 KB 1 2/9/2021 3:02:56... &/19/2021 ¢:10:1... Inbox
~iamadmin  drooping ... 8.28 KB 1 2/972021 3:02:55... &/19j2021 ¢:10:1... Inbox hd
< >
| Laad | | Save ‘ - Display Close

Query: Ssubject contains "them” OR Folder path Inbox AND Sender is "amadmin”
OR item has an attachment

This query can be splitinto three parts

1. Subject contains "them” OR

2. Folder path is "Inbox" AND Sender is "amadmin"
3. ORitem has an attachment

The AND operator has a higher priority so the conditions with the AND operator must be fulfilled
first. In this case the search result will contain items where Subject must contain the word "them”
or folder path must be "Inbox” and Sender must be "amadmin” or the item has an attachment.

4

Keyword Search

Keyword search provides a fast and flexible search for keywords in the email Subject, body, and
attachments of messages in Archive Manager for Exchange. If you leave this field empty, then the
search result will show all archived messages. If you enter a word or phrase in the keyword field
and click Search the result of the search will show all the archived messages where the Subject,
body or attachment contains the entered word or phrase.

Example 1

You can combine keyword searches with advanced search clauses to find specific messages.
Keyword searches are combined with advanced search conditions with the AND operator. The
search result will contain items that have the keyword and the advanced search conditions as
well. To find all messages where the Subject, body or attachment contains word "mother" and
the Subject also contains the word "them", the search query is as shown:
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Keyword search rPER

Keyward: |mnthar | | Search || Clear |
Advanced search
=]
Advanced " Mailboxes " Settings ]
And/Or  Field Operakaor Yalue
+ X[ ‘Subject v||Contains V||them
+ Add new clause
Search results: 1 messages found
From Subject Attachment Size Versian Received Archived date  Folder
=] afthemh... 1) 91,62 KB 1 209{2021 2:46:29...  §19/2021 4:10:5... Inbox
< >
| Laad || Save ‘ - | Display | Close

The body of the message contains word "mother", and the Subject contains word "them"

NOTE: To search in journal mailboxes:

o If auser has Journal permission set in ArchiveWeb then the user can search through their
own emails, where it is present as a kind of recipient (sender, recipient).

o If auser has Journal access granted through Archive Manager > Tools > Mailbox rights
manager, then the user can search all emails in the Journal.
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6

Versions

Each time you retrieve and edit an archived email a new version of that email is created in the
HSM Store. Versions are also created automatically when Archive Manager is configured to create
a delayed shortcut. For example if you have an email that is archived with a delayed shortcut, the
original email is still available in you mailbox even though it is marked to be archived. If you edit
and save this this email and it is eventually archived, a new version of the email will be created.

Different versions of an archived email can be checked in the Versions window.

Steps to work with the Versions window
1. Click the Archive Manager addin.

2. Select an archived email and click Versions from the ribbon.

= 2= Inbox - timashford@democorp.com - Cutlook

File Home Send / Receive Folder View Help ARCHIVE MAMAGER Q Tell me what you want to do

=4 M Bk|em| 40 2 &
Restore Delete | Versions Search Offline folder Options Info

synchronization

Archive Restore Keyword search | Offline folder synchronization| Options Info o

3. If the archived email has versions, then all the versions will be displayed in the list.

Version From Subject Size Received Archived date
z nikiportman @democorp.com  Housekeeping 96 KB 9/10/2020 10:34:00 PM  1/28/2021 7:14:02 AM
= nikipartman@democorp.com  Housekeeping 7.04KB 9/10/2020 10:34:00PM  1/28/20216:53:33 AM

| Restore | | Create new copy | = | Display | | Close

The actions you can perform in the Versions window are described below:
a. Display - opens the selected version of the archived email.

b. Create new copy - creates a new email based on the selected version. This newly created
email is not archived and you must archive it manually.

c. Restore - restores the selected version. The restored version of email will be retrieved and
deleted from the archive.

d. —a- click the pinicon to keep the Versions window always on top while you work with
other applications. Click to & unpin the window.
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NOTE:

® You can click any column header to sort the list based on the header.

e The keyword search engine searches for keywords in every version of the archived
emails. Search results may contain more than one version of the same email.

Keyword search =P

Keyword: |nurthwest | | Search | | Clear |

Advanced search

Search results: 5 messages found

From Subject Attachment Size  Version Received Archived date  Folder
(=4 nikiportman @democorp.com Housekeeping 7.04KB 1 9/11/2020 2:34:00 AM  1/26/2021 10:42:20 PM  Inbox
(=4 nikiportman @democorp.com Housekeeping 96 KB 2 9/11/2020 2:34:00 AM  1/28/2021 7:14:02 AM  Inbox
< >

Load | | Save | ] | Display | Close

Steps to create a new version of an archived email

1. Open Outlook.

2. Double-click an archived email to retrieve and open the email in the Outlook message editor.

3. From the Message ribbon select Actions > Edit Message.

a - 5 Housekeeping - Message (Plain Text)

Message Help Q Tell me what you want to do

D E% (E_\é E;;; [F2 Meeting v ==l P }; g AJ) Q
s

Housekeeping
-3 Other Actions 3

Fingerbone is a fictional town in the Pacific Northwest. It rests along a lake that has the distinction of once having claimed an entire train that slid from
a bridge into its dark waters one night, taking almost all on board to their deaths. Time swallows people in the same way in this sly book. The narrator
is Ruth, a teenaged girl. She and her sister are raised, affectionately but haphazardly, by various generations of the women in her all-too-eccentric
family. This is a book about women, making homes and leaving them. Even when the girls stay home, the days and nights pass and the plot goes
nowhere in particular, Robinson arrives again and again in resounding places.

Regards
Miki

:oJunk' Archive Reply Reply Forward E@More' Move Actions' Categorize Follow Read Zoom
All - = Up~ T | Aloud
Delete Respond Edit Message ] Editing Speech Zoom
nikiportman@democorp.com Tim Ashford 9/11/2020

4. Revise the message as needed and save the message.
5. Click the Archive Manager addin.

4. Select the edited archived email and click Versions from the ribbon to verify that a new
version was created and successfully archived.
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7

Offline synchronization

Working with archived emails is possible even when you use your MS Exchange Server mailbox
offline. Before switching to offline mode you must synchronize your Outlook mailbox with the
MS Exchange Server. If you also plan to work with your archived emails you must synchronize
with the Archive Manager addin as well. For automatic synchronization see Offline options.

Steps to synchronize archived emails for offline use

NOTE: To ensure the offline folder synchronization process is successful, you must
deactivate the Cached Exchange Mode in Outlook.

To deactivate Cached Exchange Mode in Outlook:
1. Click File > Account Settings > Account Settings.
2. Click the Exchange or Microsoft 365 account from the Email tab, and then click Change.

3. Under Offline Settings, uncheck Use Cached Exchange Mode. If you're a Microsoft 365
subscriber, uncheck Use Cached Exchange Mode to download email to an Outlook data
file.

4. Exit, and then restart Outlook.

Alternatively, you can keep Cached Exchange Mode activated and set Mail to keep offline
(or Download email for the past for Microsoft 365 subscribers) to a date range greater than
the received emails being deleted.

Run Outlook synchronization.
Click the Archive Manager addin.
Click Offline Folder Synchronization.

= L- - Inbox - timashford@democorp.com - Cutlook

File Home Send / Receive Falder View ARCHIVE MANAGER @ Tell me what you want to do

bz = G e
Restore Delete Versions Search Offline folder Options Info
synchronization

Archive Restore Keyword search | Offline folder synchronization | Options Info ~

When you reconnect wit MS Exchange Server online, you must synchronize your Outlook
mailbox with the MS Exchange Server. Then you must synchronize your Outlook mailbox with
the Archive Manager Server as well to update your Outlook mailbox with the current state of
all archived messages from the MS Exchange Server.
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Options

In this chapter:

e Archive options

e Offline options

e Other options

Archive Options
1. Click the Archive Manager addin.
2. Click Options to open the Options window.

Inbox - timashford@democorp.com - Outlook

Home Send / Receive Folder View Help ARCHIVE MAMNAGER Q Tell me what you want to do

D T Bk g | : | O

-'
Restore Delete Versions Search Offline folder Options Info

synchronization

Archive Restore Keyword search | Offline folder synchronization | Options Infao o~

3. Click the Archive tab.

Archive ”Df‘FIine HDther ]

Retrieve server: https: []
| AMXSERVER |

Archive server:
| AMYSERVER |

Reset ko default
Reset all settings

QK | | Cancel | | Apply
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The properties are as described below:

a.

Retrieve server - the Archive Manager server that is designated as the Retrieve serverin a
distributed deployment. In a standalone deployment, the Archive and the Retrieve servers
are the same.

. Archive server - the Archive Manager server that is designated as the Archive serverin a

distributed deployment. In a standalone deployment, the Archive and the Retrieve servers
are the same.

https - select this check box if the communication protocol with the Archive and Retrieve
servers uses the secure https protocol.

Reset to default - Archive and Retrieve server values are reset to default values specified
during the addin installation.

Reset all settings - all settings across all tabs will be reset to default values.

Offline options

1. Click the Archive Manager addin.

2. Click Options to open the Options window.

3. Click the Offline tab to configure automatic offline synchronization.

Options 3

Archive || Offline || Other

JTHIMESELINGS —

[] &uto synchronize when Outlook starts
[] Auta synchronize when Outloak exits
[] schedule offline synchronization every
30 .
~ | minutes

Showprogressdialog

Folder settings

| QK | | Cancel | Apply

The properties are as described below:

a.

Auto synchronize when Outlook starts - select this check box to synchronize the Outlook
client with the Exchange sever when Outlook starts.
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b. Auto synchronize when Outlook exits - select this check box to synchronize the Outlook
client with the Exchange sever when Outlook exits.

c. Schedule offline synchronization every - select this check box to schedule offline
synchronization and specify the frequency in minutes. This is a useful option if network
interruptions are expected.

d. Show progress dialog - select this check box to display the progress dialog whenever the
scheduled offline synchronization runs.

4. Click Folder settings to open the Offline and cache settings window where you can manage the
addin cache and specify cache settings for each mailbox folder of the Outlook user.

Offline and cache settings >4
_@Qu‘.: roldEr” R

Current location:
|C:‘JJsers\umashford\AppDam‘Rcamlng\l\‘lemloglx Software\Archive Manager\ADDINCAC?—|

Limit: 2048 MB Settings

DJ’JJ;: IOYdErS ]

[] Use Qutlook's offline settings

Select folders for offline synchronization:

=--[J25} timashford @democorp. com ~
JDE Calendar by size
0-[ |84 Contacts

[ -3 Conversation Action Setting
~{]7a] Deleted Items

[ 177 Drafts

[ 173 ExternalContacts =] days
[ 173 Files

]D_;] Inbox

Déﬁ Journal

- 173 Junk Email

] Notes

D-EI Qutbox

- 173 Quick Step Settings o

by date

‘ o4 | | Cancel

Apply

The properties and actions are as described below:
Cache folder
a. Currentlocation - indicates the location of the cache folder.

b. Click Settings to open the Cache folder settings window. Here you can set the global size
limit OR the global date limit for the cache folder. (Do not forget to check the Limit cache
by date check box if you want to apply the date limit.)

Cache folder settings B

Cache folder limit:
' 2098 || MB

[] Limit cache by date

730 = d ays

K | | Zancel
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Set the cache limits as described below:

1 | NOTE: When reducing the cache size or date limit, the add-in will ask if you want to
delete the oldest items if the actual status of the cache exceeds the defined values.

i. Cache folder limit - drag the slider to set a size limit for the cache folder or set the limit
directly in the size counter. Size limits are defined in MB.

ii. Limit cache by date - select this check box to set the number of days the cache contents
will be retained. If this check box is checked the Cache folder limitis ignored. For
example, emails older than 730 days will not be cached during offline folder
synchronization. The user working offline will be able to see the shortcuts of all
archived emails but will be able to work with only those emails that were received in
last 730 days.

iii. Click OK to save the cache limit settings.
c. Click Clear cache to clear the cache folder.
Offline folders

a. Use Outlook's offline settings - select this check box to allow the add-in to synchronize
folders that are defined in the Outlook settings. Clear this check box to customize cache
limits for selected folders.

b. Custom limits for selected folders. The custom cache size and date limits defined for
individual folders are applicable only within the range of the global limits specified in the
Cache folder settings section as described above.

Offline and cache settings B
;@ CaChiEFold ey

Current location:
|C:‘U_Isers\ﬁmashfnrd\.-'-\ppData\RDaming\Jt‘letalogix Software‘archive Manager\ADDINCACI—|

Limit: 2048 MB Setkings
OFHmeE i Ers:

[] Use Outlook’s offline settings

Select folders for offiine synchronization:

BD:E:,U timashford @democorp.com F

(-8 Calendar [ by size

-84 Contacts

B_J Conversation Action Setting hd

[ ]3] Deleted Items

D_/_ZI Drafts by date

[ 13 ExternalContacts 15

-3 Files

Q] inbox

D\gﬂ Journal

13 Junk Emall

[ Jlu| MNotes

D.ﬂ Outbax

D_J psT

-3 Quick Step Settings w
—

Limit folder

2 days

&

| Ok | | Cancel | | Apply

To set the cache size and limits:

i. Selectafolder.
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ii. Inthe Limit folder area for the selected folder, select the check box for the cache size or
date or both, and set the limits.

Offline and cache settings -
_@_ acheolder”

Current location:
|C:\JJsers\ﬁmashﬁ)rd\AppDaE\Rcaming\,Meiangix Software\Archive Manager\,ﬂDDINCAC}-|

Limit: 2048 MB Settings
Dﬁj.': rold Ers’

[] Use Cutlook’s offline settings

|

Select folders for offline synchronization:

BD‘E:-,S timashford @democorp.com ~
JDE Calendar [ by size
#-{ 65 Contacts
D_] Conversation Action Setting
D@ Deleted Items

[] by date
) Drﬂﬁs Y
[ -3 ExternalContacts 15 =] days
-[123 Files
J—_l g Check subfolders

éﬂ Journ,
[1°3 unkE % Uncheck subfolders
] Motes ‘b, Apply the same setting for subfolders

DDQJ gsu_rﬂm X Clear limits for subfolders

{';‘Lj Quidistelp Settings o

Limit folder

< >

‘ OK | | Cancel | | Apply |

iii. To manage subfolders right-click a folder to select the options in the context-menu. For
example, if you set the date limit to 15 days for the Inbox folder and select the Apply
the same settings for subfolders option from the context menu then the same date
limit is set for every Inbox subfolder.

5. Click OK to save the settings and close the Offline and cache settings window.

Other options

1. Click the Archive Manager addin.

2. Click Options to open the Options window.
3. Click the Other tab.

4. Choose the preferred language for the addin.
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Info

The Info feature presents information about the Archive Manager addin and allows you to
manage the addin connectivity.

Steps to work with the Info feature
1. Click the Archive Manager addin.

2. Click Info from the ribbon.

E‘Ij 3 - 5 Inbox - timashford @democorp.com - Outlook

File Home Send / Receive Falder View ARCHIVE MANAGER Q Tell me what you want to do

b (3 BX £ a : g || O
ault
Restore Delete Versions Search Offline folder Options Info

synchronization

Archive Restore Keyword search | Offline folder synchronization | Options Info -~

3. The About Archive Manager window opens. This window displays the current version as well
as the current status of the addin.

About Archive Manager Outlook Addin

Archive Manager Cutook Addin
Yersion 8.6.0
Cutook WSTO Addin for Archive Manager

7 Connected with user: amadmin
[amadmin@am 13.local]
Server MAM1S

(SS))
Y

Ceactvate

The Addin is currently activated
The Addinis orline Reconnect

k.

4. Click Deactivate to disconnect the addin from the Archive Manager server.

5. Click Reconnect to synchronize the addin with any changes changes made by the administrator
inthe AMAC.

6. Click OKto close the About Archive Manager window.
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About Us

Quest creates software solutions that make the benefits of new technology real in an
increasingly complex IT landscape. From database and systems management, to Active Directory
and Office 365 management, and cyber security resilience, Quest helps customers solve their
next IT challenge now. Around the globe, more than 130,000 companies and 95% of the Fortune
500 count on Quest to deliver proactive management and monitoring for the next enterprise
initiative, find the next solution for complex Microsoft challenges and stay ahead of the next
threat. Quest Software. Where next meets now. For more information, visit www.quest.com.

Contacting Quest

For sales or otherinquiries, visit www.quest.com/contact.

Technical Support Resources

Technical support is available to Quest customers with a valid maintenance contract and
customers who have trial versions. You can access the Quest Support Portal at
https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and
independently, 24 hours a day, 365 days a year. The Support Portal allows you to:

e Submit and manage a Service Request
e View Knowledge Base articles
e Sign up for product notifications

Download software and technical documentation

View how-to-videos

e Engage in community discussions

Chat with support engineers online

e View services to assist you with your product
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